This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by CA at any time.

This Documentation may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Documentation is confidential and proprietary information of CA and may not be disclosed by you or used for any purpose other than as may be permitted in (i) a separate agreement between you and CA governing your use of the CA software to which the Documentation relates; or (ii) a separate confidentiality agreement between you and CA.

Notwithstanding the foregoing, if you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make available a reasonable number of copies of the Documentation for internal use by you and your employees in connection with that software, provided that all CA copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your responsibility to certify in writing to CA that all copies and partial copies of the Documentation have been returned to CA or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS DOCUMENTATION “AS IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and such license agreement is not modified in any way by the terms of this notice.

The manufacturer of this Documentation is CA.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)(3), as applicable, or their successors.

Copyright © 2012 CA. All rights reserved. All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.
CA Technologies Product References

This document references the following CA Technologies products:

- CA ERwin® Data Modeler Workgroup Edition (CA ERwin DM WE)
- CA ERwin® Data Modeler Standard Edition (CA ERwin DM)
- CA ERwin® Data Modeler Navigator Edition (CA ERwin DM NE)
Contact CA Technologies

Understanding your Support

Review support maintenance programs and offerings.

Registering for Support

Access the CA Support online registration site to register for product support.

Accessing Technical Support

For your convenience, CA Technologies provides easy access to "One Stop" support for all editions of CA ERwin Data Modeler, and includes the following:

- Online and telephone contact information for technical assistance and customer services
- Information about user communities and forums
- Product and documentation downloads
- CA Support policies and guidelines
- Other helpful resources appropriate for your product

For information about other Home Office, Small Business, and Enterprise CA Technologies products, visit http://ca.com/support.

Provide Feedback

If you have comments or questions about CA Technologies product documentation, you can send a message to techpubs@ca.com.

If you would like to provide feedback about CA Technologies product documentation, complete our short customer survey, which is also available on the CA Support website, found at http://ca.com/docs.

CA ERwin Data Modeler News and Events

Visit www.erwin.com to get up-to-date news, announcements, and events. View video demos and read up on customer success stories and articles by industry experts.
Documentation Changes

The following documentation updates have been made since the last release (r8.2) of this documentation:

- **Administer Mart** (see page 11)—Added the topic to describe how to administer the Mart. This chapter provides information on how to upgrade Mart (see page 11), how to add users (see page 26) and how to delete Mart (see page 41).
Contents

Chapter 1: Modeling in the Multiuser Environment ................................................. 9
Microsoft SQL Server 2005 Permissions ................................................................. 9
Specify Use of Foreign Characters With Microsoft SQL Server 2000 ..................... 9
Specify Use of Foreign Characters With Microsoft SQL Server 2005 .................... 10
Standards Tools ...................................................................................................... 10

Chapter 2: Administer Mart .................................................................................. 11
Upgrading Mart ...................................................................................................... 11
  Review the Prerequisites ..................................................................................... 13
  Select the Working Directory .......................................................................... 15
  Enter the Source Mart Details ......................................................................... 16
  Enter the Destination Mart Details .................................................................. 17
  Select the Data to Upgrade ............................................................................ 18
  Select Upgrade Options .................................................................................. 20
  Select Models .................................................................................................. 21
  View the Upgrade Status ................................................................................ 22
  Log Files ........................................................................................................... 23
  Troubleshooting .............................................................................................. 23
Adding a User ....................................................................................................... 26
  Add a User ....................................................................................................... 27
  Verify if an Existing Profile Suits the User ..................................................... 29
  Create a Profile ............................................................................................... 36
  Verify if the Required Library Exists ............................................................. 37
  Create a Library .............................................................................................. 37
  Assign Permissions to a User ......................................................................... 38
  Examples .......................................................................................................... 39
Sessions ................................................................................................................. 40
  Terminate Inactive or Closed Sessions ......................................................... 40
Delete Mart ........................................................................................................... 41
Catalog Management ......................................................................................... 41
  Library Structure Planning ........................................................................... 41
  Library Structure Organization ....................................................................... 42
  Library Security Levels .................................................................................. 42
  Library Structure Considerations .................................................................. 43
  Manage Catalogs ............................................................................................ 44
Chapter 3: Workgroup Modeling Reports

Generate a Global Report ................................................................. 51
Generate a Model Validation Report .................................................. 53
Generate a Diagram Report ............................................................... 55
Generate a Model Lock Report .......................................................... 56
Generate a Report on Model Contents by Class .................................... 57
The Report Viewer ........................................................................... 58

Chapter 4: Generate the Current Diagram Picture

Index

8 Administration Guide
Chapter 1: Modeling in the Multiuser Environment

CA ERwin DM Workgroup Edition coordinates the development and management of data models created with CA ERwin DM.

This section contains the following topics:

Microsoft SQL Server 2005 Permissions (see page 9)
Specify Use of Foreign Characters With Microsoft SQL Server 2000 (see page 9)
Specify Use of Foreign Characters With Microsoft SQL Server 2005 (see page 10)
Standards Tools (see page 10)

Microsoft SQL Server 2005 Permissions

For SQL Server 2000, you only need the public permission assigned to save to Mart. However, when the repository is on a SQL Server 2005 instance, you must have the bulkadmin permission designated too. The ability to do bulk inserts (which the public permission permitted previously) is no longer part of the public permission. As the administrator, you explicitly define this permission. Assign the bulkadmin permission to the physical user that connects to the database. If you do not define the permission, when you create a mart using a SQL Server 2005 database, and save it, an error appears.

Specify Use of Foreign Characters With Microsoft SQL Server 2000

For Microsoft SQL Server 2000, select specific settings in the Client Network Utility to have certain foreign language characters in your models recognized.

Follow these steps:
1. Click Programs, Microsoft SQL Server, Client Network Utility on the Start menu. The SQL Server Client Network Utility dialog opens.
2. Select the following check boxes on the DB-Library Options tab:
   - Automatic ANSI to OEM conversion
   - Use international settings
3. Click OK.

Your configuration is set to recognize foreign language characters in your models.
Specify Use of Foreign Characters With Microsoft SQL Server 2005

For Microsoft SQL Server 2005, 2008, and 2012 modify your registry settings to have certain foreign language characters in your models recognized.

Follow these steps:
1. Click Run on the Start menu.
2. Enter regedit.
   The Registry Editor opens.
3. Verify or add the following registry entry:
   [HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSSQLServer\Client\DB-Lib]
   "AutoAnsiToOem"="ON"
   "UseIntlSettings"="ON"
4. Click File, Exit.
   Your configuration is set to recognize foreign language characters in your models.

Standards Tools

A naming standards tool and data type standards tool help your workgroup create and manage model naming and data type standards. Because naming and data type standards use external files, as the administrator, you can manage these files in the mart.

Note: For more information about these tools, see the CA ERwin DM Online Help.
Chapter 2: Administer Mart

This section contains the following topics:

- Upgrading Mart (see page 11)
- Adding a User (see page 26)
- Sessions (see page 40)
- Delete Mart (see page 41)
- Catalog Management (see page 41)

Upgrading Mart

Earlier, when you upgraded to a new version of CA ERwin DM, only the schema was upgraded. To upgrade your models, you opened each model in the new version. This process took much of your time, especially when you had to upgrade large models. In CA ERwin DM Version 9.0, upgrading models is automated through the Mart Upgrade utility. The utility lets you upgrade not just models, but users, profiles, and permissions too. In addition, the utility also lets you upgrade to a different database.

If your source Mart version is release 7.0 through 7.3.11, the upgrade happens in two stages. First, the Mart is upgraded to CA ERwin DM version 8.0 and then it is upgraded to version 9.0. The existing upgrade process is used to upgrade from a lower version to 8.0. After the source Mart is brought up to version 8.0, the new Upgrade Mart utility is used to upgrade to version 9.0. In the new Upgrade Mart utility, you must select the models that you want to upgrade.

Note: The Upgrade Mart utility is available only if you install it while installing CA ERwin DM Version 9.0.

The Upgrade Mart utility lets you upgrade models in several ways. You can choose the best way that helps you get started with your work quickly. Upgrade models in one of the following ways:

- Upgrade the top ‘n’ versions.
- Upgrade only the marked versions.
- Upgrade all marked versions and top ‘n’ versions.
- Upgrade all the versions of all the models.
Regardless of the option you select, you can start working on a model after the model is upgraded. You do not need to wait until all the models are upgraded.

The Upgrade Mart utility lets you pause the process any time and start again. When you pause, the utility completes upgrading the current model before stopping. When you restart the upgrade process, the utility continues from the point it had stopped. The utility then displays the models that are not yet upgraded in the list of models that you had selected.

The following diagram illustrates how you upgrade models:

Complete the following tasks to upgrade Mart:
1. Review the prerequisites, (see page 13)
2. Select the working directory, (see page 15)
3. Enter the source Mart details, (see page 16)
4. Enter the destination Mart details, (see page 17)
5. Select the data to upgrade, (see page 18)
6. Select upgrade options, (see page 20)
7. Select models, (see page 21)
8. View the upgrade status, (see page 22)
Review the Prerequisites

Review the following prerequisites:

- The models in the source Mart do not have any locks.
- CA ERwin DM release 9.0 Mart is installed.
- A minimum of 2-GB space is available on the drive on which you select the working directory.
- Prerequisites for the computer on which you run the upgrade process are as follows:
  - The operating system is 32-bit. If you are using a 64-bit operating system and the application does not work, see the Running CA ERwin DM on a 64-bit Operating System (see page 13) topic.
  - A licensed copy of CA ERwin DM release 8.x is available.

  **Note:** If you are using CA ERwin DM release 8.0 or 8.1, copy the license as follows:

  **For Windows XP and Windows 2003**
  
  Copy from: C:\Documents and Settings\<user id>\Local Settings\Application Data\CA\ERwin Data Modeler\8.0
  
  Copy to: C:\Documents and Settings\All Users\Application Data\CA\ERwin Data Modeler\8

  **For Windows 7 and Windows 2008**
  
  Copy from: C:\Users\<user id>\AppData\Local\CA\ERwin Data Modeler\8.0
  
  Copy to: C:\ProgramData\CA\ERwin Data Modeler\8

- The database client for the source Mart database is installed. For example, for a Microsoft SQL Server Mart, install the SQL Server Native Client on the computer that is designated to run the upgrade process.

Running CA ERwin DM on a 64-bit Operating System

If you have installed CA ERwin DM on a 64-bit operating system, the application may not run properly. CA ERwin DM APIs use 32-bit COM objects and these objects are not designed for use in a 64-bit environment.

**Follow these steps:**

1. Paste the code included at the bottom of this topic to a Notepad file and name it as 64_Bit_Upgrade.reg. Note down the folder where you have created this file.
2. After installing CA ERwin DM version 9.0, right-click 64_Bit_Upgrade.reg and select Merge.

3. From the Windows Start menu, go to Run and type the following commands to re-register the r8 and r9 EAL components:
   
   ```
   regsvr32.exe "<Install Dir>\CA\ERwin Data Modeler r9\EAL.dll"
   regsvr32.exe "<Install Dir>\CA\ERwin Data Modeler r9\Upgrade\R8_Binaries\EAL.dll".
   ```

4. Right-click 64_Bit_Upgrade.reg and select Merge again.
   
   You can now upgrade to version 9.0 Mart on a 64-bit computer.

---

**64_Bit_Upgrade.reg**

Copy the following code and paste it to a new Notepad file:

```text
Windows Registry Editor Version 5.00

[HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{9527D0BA-ED75-4b0e-BF4B-E35565DE9852}]
@="CA ERwin Data Modeler Script Client API"
"AppID"="{9527D0BA-ED75-4b0e-BF4B-E35565DE9852}"
[HKEY_CLASSES_ROOT\Wow6432Node\AppID\{9527D0BA-ED75-4b0e-BF4B-E35565DE9852}]
"DllSurrogate"=""
[HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{40FDB0E6-D772-455d-B1C8-83CE79445403}]
@="CA ERwin Data Modeler Script Client API Property Bag"
"AppID"="{40FDB0E6-D772-455d-B1C8-83CE79445403}"
[HKEY_CLASSES_ROOT\Wow6432Node\AppID\{40FDB0E6-D772-455d-B1C8-83CE79445403}]
"DllSurrogate"=""
[HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{6774E2C3-06E9-4943-A8D4-E3007AB1F42E}]
@="CA ERwin Data Modeler Script Client API"
"AppID"="{6774E2C3-06E9-4943-A8D4-E3007AB1F42E}"
[HKEY_CLASSES_ROOT\Wow6432Node\AppID\{6774E2C3-06E9-4943-A8D4-E3007AB1F42E}]
"DllSurrogate"=""
[HKEY_CLASSES_ROOT\Wow6432Node\CLSID\{7D7B1602-9832-4ac6-A224-F0092FAF0D7E}]
@="CA ERwin Data Modeler Script Client API Property Bag"
"APPID"="{7D7B1602-9832-4ac6-A224-F0092FAF0D7E}"
```
Select the Working Directory

Working directory is the folder where the configuration and log files are stored. This directory is continuously used during the Mart upgrade process. You can use the same working directory to upgrade all your models, or you can use a different directory for a different set of models. However, we recommend that you use the same working directory for all your models.

If you pause the upgrade process and continue later, you can select the same working directory. If you select the same working directory, all the details you have previously entered are populated, except for the password. You cannot change the details.

Follow these steps:

1. From the Windows Start menu, open the Upgrade Mart utility.
   
   The Mart Upgrade dialog appears.

2. Select a folder on a drive that has a minimum of 2-GB free space.
   
   The message, If your source Mart version is release 7.0 through 7.3.11, you must first upgrade it to release 8. Click Yes to upgrade appears.

3. If your source Mart is CA ERwin DM 7.0 through 7.3.11, click Yes.
   
   The Connection Manager dialog appears.

   a. Enter the details that are required to connect to the source Mart. Click Connect.

   The Mart dialog appears.
b. Click Update.
   The source Mart is upgraded to CA ERwin DM release 8.0.

c. Click Close.
   The current wizard closes and the Upgrade Wizard appears. The Upgrade Wizard lets you upgrade from CA ERwin DM release 8.0 or later to version 9.0.

4. If your source Mart is CA ERwin DM 8.0 through 8.2.5, click No.
   The Upgrade Wizard appears.

**Enter the Source Mart Details**

When you upgrade Mart, CA ERwin DM connects to your existing Mart to get your models. Provide your existing Mart information, including the user credentials. If you restart the upgrade process and select an existing working directory, the details you have selected previously are populated, except the password. You cannot change the details.

*Note:* If your source Mart is CA ERwin DM release 7.0 through 7.3.11, enter the same details that you provided in the Connection Manager dialog.

**Follow these steps:**

1. In the Upgrade Wizard, click Source Mart Details.
2. Complete the following fields:
   
   **Database Type**
   Specifies the type of Mart database.

   **Server**
   Specifies the server on which the source Mart is hosted. This parameter is not valid for Oracle.

   **Database**
   Specifies the database on which the source Mart is hosted. This parameter is not valid for Oracle.

   **Connection String**
   Specifies the connection string that is required to connect to a database. This parameter is valid only for Oracle.
Authentication

Specifies the type of authentication you use to connect to Mart.

User Name

Specifies the user name to connect to Mart.

Password

Specifies the password to connect to Mart.

3. Click Test Connection.

If the data that you have provided is valid, a message appears that the connection is successful. If the connection fails, enter valid data and test again.

Enter the Destination Mart Details

When you upgrade Mart, models in your existing version of CA ERwin DM are converted to CA ERwin DM Version 9. The destination Mart is a CA ERwin DM Version 9 Mart and the Mart database can be any database. For example, if your source Mart database is Microsoft SQL Server, the destination Mart database can be Oracle 11g.

At any time if you restart the upgrade process and select an existing working directory, the details you have selected previously are populated. The password is not populated.

Follow these steps:

1. On Upgrade Wizard, click Destination Mart Details.
2. Complete the following fields:

   Server Name
   
   Defines the name of the web server where you have installed the Mart.

   Application Name
   
   Defines the application name of the Mart that you want to connect to.

   Default: MartServer

   Port No.
   
   Specifies the port number to access the web server.

   Use IIS
   
   Specifies that you want to use IIS to connect to Mart. This check box is available only if you have configured IIS.

   Authentication
   
   Specifies the type of authentication you want to use.
User Name
Defines the name of the user.

Password
Defines the password of the user.

3. Click Test Connection.
If the data that you have provided is valid, a message appears that the connection is successful. If the connection fails, enter valid data and test again.

Select the Data to Upgrade

The Upgrade Mart utility lets you upgrade not just models, but users, profiles, and permissions too. Select the objects that you want to upgrade, including the versions of models.

Note: Suppose that your source Mart version is CA ERwin DM release 7.0 through 7.3.11, and you complete upgrading it to 8.0. You must still select the models that you want to upgrade to version 9.0.

You can upgrade models in the following ways:
- Upgrade the top ‘n’ versions.
- Upgrade only the marked versions.
- Upgrade all marked versions and top ‘n’ versions.
- Upgrade all the versions of all the models.

Choose the best way that helps you get started with your work quickly.

The time that is taken to upgrade models depends on the number of models and number of versions of models present in your Mart. If you choose to upgrade only selected versions, the Upgrade Mart utility first upgrades the selected versions and then the remaining versions.

If you restart the upgrade process and select the same working directory, the details you have selected previously are populated, except for the password.
Follow these steps:

1. On Upgrade Wizard, click Data to Upgrade.
2. Complete the following fields:

   **Upgrade Users**

   Specifies that you want to upgrade users. The users are upgraded and the passwords of Server and Windows users are left blank. The upgraded users are assigned to their corresponding models and versions as owners. If users are not upgraded, the owners for models and versions are left blank. After the users are upgraded, open CA ERwin Mart Administrator and for each user, enter the email ID and reset the password.

   **Upgrade Models**

   Specifies that you want to upgrade models.

   *Note:* You can upgrade models only if users and profiles are upgraded.

   **Upgrade Profiles**

   Specifies that you want to upgrade profiles. If a profile matches with a profile in the source Mart, the corresponding profile available in CA ERwin DM Version 9.0 is used. If a profile does not match with any profile in the source Mart, then it is created.

   **Upgrade Permissions**

   Specifies that you want to upgrade permissions. Permissions are upgraded only if users, models, and profiles are upgraded.

   *Note:* Subject Area-level permissions are ignored when you upgrade permissions to CA ERwin DM Version 9.0.

To Select the Top 'n' Versions

   **Selective**

   Specifies that you want to upgrade the selected versions first.

   **No. of Top Versions to Upgrade**

   Specifies the number of top versions that you want to upgrade. Only those versions are selected from your Mart that are not marked versions and are not deleted. These models are upgraded first and then the remaining models are upgraded.

   *Note:* To upgrade only the marked versions of all models, enter zero for **No. of Top Versions to Upgrade**.
To Select the All the Marked Versions

All Marked Versions

Specifies that you want to upgrade the all the marked versions. If you specify the number of top versions to upgrade, all the marked versions are upgraded first and then the top n versions are upgraded.

To Select All the Versions

All

Specifies that you want to upgrade all the versions. In the first iteration, the newest versions of all models are upgraded. In the next iteration, the next-newest versions are upgraded. This process goes on until all the versions are upgraded.

Select Upgrade Options

If you are upgrading from CA ERwin DM Version 7.0 through 7.3.11, you can select the upgrade options for the main subject areas and transforms. At any time if you restart the upgrade process and select an existing working directory, the details you have selected previously are filled up automatically.

Follow these steps:

1. On Upgrade Wizard, click Upgrade Options.
2. Complete the fields. The following fields are not self-explanatory:

   Keep the Main Subject Area
   
   Specifies that you want to keep the main subject area.

   Keep the Diagrams for the Main Subject Area
   
   Specifies that you want to keep the diagrams for the main subject area.

   TimeOut (in Min)
   
   Specifies the time for which the utility waits for the following events:

   - Open an older version of the model and save it to disk: If a model version is not saved to disk in this time, this thread of the process is relaunched and the next model is saved.

   - Open a version of a model and save it to CA ERwin DM Version 9 Mart: If a model is not saved in this time, the utility relaunches this thread of the process.

   Default: 60 minutes
Retries for a Model

Specifies the number of times the utility tries to open a model version. For example, suppose that you set the value of this parameter as 3. If a model version does not load within the time specified in the TimeOut field, the utility tries to open it again. The utility tries this three times; if it is still not successful, then it moves on to the next model version.

Export Library Name

Specifies a library in the destination Mart, where you want to copy the upgraded models. Use this option if you want to copy the upgraded libraries to a specific library. If no name is provided, the libraries are copied in the root of Mart.

Select Models

The libraries and models of the source Mart are displayed in the form of a tree. You can select an entire library or an individual model under a library to upgrade. This selection and the versions you selected previously, determine the models and versions you want to upgrade. For example, suppose that you have selected to upgrade the top five versions. If you select nine models on the Select Models window, the top five versions of all the nine models are upgraded.

Follow these steps:

1. Click Select Models on Upgrade Wizard.

The models that satisfy the criteria selected in the Data to Upgrade dialog are displayed. If you restart the upgrade process, only those models that are not upgraded are available for selection.
2. Select the libraries or individual models that you want to upgrade.

   If a library or model name contains special characters (?, $, ', \), they are converted to underscore (_) when displayed on this dialog.

   **Note:** If a library or model name contains a forward slash ('/'), it is not upgraded.

3. Click Finish.

   Upgrading starts and the Upgrade Progress dialog displays the progress.

**Pause and play**

The Upgrade Mart utility lets you pause the process any time and start again. When you pause, the utility completes upgrading the current model before stopping. When you restart the upgrade process, the utility continues from the point it had stopped. The utility then displays the models that are not yet upgraded in the list of models that you had selected. If there are several models remaining, you can select a few to upgrade. If you select the same working directory, the source and destination Mart and the model version details are filled up automatically.

If your source Mart version is older than CA ERwin DM 8.0, it is upgraded to 8.0 only once. If you upgrade a model to 8.0 and you pause the upgrade process, then the option to upgrade to 8.0 does not display again.

**Note:** When you pause and restart the upgrade process, you can select all the remaining models or a few models from the original list of models. Suppose that you have three libraries A, B, and C in the catalog and you select only A to upgrade. Suppose that there are ten models in library A. If you pause after the fifth model and you restart the process, only the remaining five models from library A are displayed.

**View the Upgrade Status**

You can view the status of upgrade, when upgrade is in progress. The Upgrade Progress dialog displays the model that is being upgraded. This information helps you determine when to pause the upgrade process, if necessary.

**Note:** If your source Mart is older than 8.0, the Upgrade Process dialog does not display the status of upgrade from the older version to 8.0. The Upgrade Progress dialog displays the status of upgrade from CA ERwin DM release 8.0 or later to version 9.0 only.

To view the upgrade status, click Details on the Upgrade Progress dialog. The Mart Upgrade status dialog appears and displays the libraries and models that are selected for upgrade, in the form of a tree. The status of each model is indicated next to the model.
Log Files

The Mart Upgrade utility creates the following log files in the working directory:

LogFile_Fetch_Models.txt
- Includes problems if any, while fetching models to display in the model tree.

NamesWithSlash.txt
- Includes the names of libraries or models that have a forward slash (/). If any of the model or library names has a forward slash (/), such names are not displayed in the model tree. Log on to the source Mart, change such names, and then load the models again.

SourceMartLogFile.txt
- Includes any error that is displayed while opening models from the source Mart.

DestinationMartLogFile.txt
- Includes any error that is displayed while saving models to the destination Mart.

Troubleshooting

Test Connection Failed--Source Mart

Symptom:

The Mart Upgrade utility is not connecting to the source Mart.

This problem can be for one of the following reasons:

- The details for the source Mart are incorrect.
- The database client is not installed.
- The source database is not started.
- The source database is not able to connect from the client computer.

Solution:

Depending on the reason, use one of the following solutions:

- Ensure that the database details are correct.
- Ensure that a database client installed on the computer where you want to run the Mart Upgrade Utility.
- Ensure that the database is running.
- Ensure that you can connect to the source Mart with the database client installed on your computer.
Your License does not Permit Connection to this Mart

Symptom:
The Mart Upgrade utility is not connecting to the source Mart.
This problem could be for one of the following reasons:
■ The computer does not have a valid CA ERwin DM Release 8 license.
■ The source Mart version is older than CA ERwin DM Release 8.

Solution:
Depending on the reason, use one of the following solutions:
■ If you are using CA ERwin DM release 8.0 or 8.1, copy the license as follows:
  For Windows XP and Windows 2003
    Copy from: C:\Documents and Settings\<user id>\Local Settings\Application Data\CA\ERwin Data Modeler\8.0
    Copy to: C:\Documents and Settings\All Users\Application Data\CA\ERwin Data Modeler\8
  For Windows 7 and Windows 2008:
    Copy from: C:\Users\<user id>\AppData\Local\CA\ERwin Data Modeler\8.0
    Copy to: C:\ProgramData\CA\ERwin Data Modeler\8
■ Upgrade the source Mart to CA ERwin DM release 8.x and then run the Mart Upgrade utility.
Test Connection Failed--Destination Mart

Symptom:
The Mart Upgrade utility is not connecting to the destination Mart.
This problem can be for one of the following reasons:
■ The web server details are wrong.
■ The web server is not started.
■ Mart cannot connect to the web server.
■ IIS is not configured correctly (if you are connecting to Mart using IIS).

Solution:
Depending on the reason, use one of the following solutions:
■ Ensure that the web server is running.
■ Ensure that the web server details are correct.
■ Ensure that you can connect to the web server from the computer on which you are running the Mart Upgrade utility. Try to log in to CA ERwin Mart Administrator to help ensure that the connection can be established.
■ Ensure that IIS is configured properly.

Unable to Select Upgrade Models Check Box

Symptom:
I am unable to select only the Upgrade Models check box in the Data to Upgrade step.

Solution:
When you select the data that you want to upgrade, you cannot select only the Upgrade Models check box. The reason is, you can upgrade models only if users and profiles are upgraded.
Adding a User

As a System Administrator, after installing Mart, you add users, create libraries, and give permissions to users on the required libraries. You know which user should be of what type. You have the details of the profiles you want to create, and you know which profile to assign to which user.

This scenario describes how you can add users to Mart.

The following diagram illustrates how to add a user to Mart:

The following tasks describe how to add a user:
1. Add a user.
2. Verify if an existing profile suits the user.
3. Create a profile.
4. Verify if the required catalog or library exists.
5. Create a catalog or library.
6. Assign permissions to the user.
Add a User

As a Mart Administrator, you can add users so that they can access Mart. You delete users if they are not required to access the Mart. You know the type of user you want to add—a user that is authenticated by Mart, a user that is authenticated by the Windows network, or a Windows user group.

Follow these steps:

1. Open CA ERwin Mart Administrator.
2. Click User Management, Add User.
3. Select one of the following options for User Type:
   - **Server User**
     Specifies a Mart user that is authenticated by the credentials provided in Mart.
   - **Windows User**
     Specifies a Mart user that is authenticated by the Windows network.
   - **Group User**
     Specifies a Windows user group. All users that are part of the selected group can access Mart.
4. Enter the user name and email address. Confirm the email address.
   - **Note:** The user name field is displayed only for the Server User and Windows User options.
5. Click Save.
   The user account is added and an email is sent to the user.

Mart Users

From r9 onwards, you can add individual users and Active Directory user groups to Mart. Individual users are categorized as Server users and Windows users, which are based on the way they are authenticated. There are no database users in CA ERwin DM Version 9 Mart.
The descriptions of user types are as follows:

**Server User**

Specifies the user that is authenticated by the Mart server. The server user is an application level user and not a database user. A server user provides the user name and password to log on to Mart. For example, Peter is a Business Analyst and reviews data models. Add Peter as a Server user as he accesses Mart only at the time of reviewing data models. Peter provides his user name and password to connect to Mart.

**Note:** Only a Server user can access CA ERwin Mart Administrator. There are no database level users in CA ERwin DM Version 9 Mart.

**Windows User**

Specifies the user that is authenticated by the Windows network. A Windows user need not provide the user name and password to log on to Mart. For example, Jane is a Data Modeler who works on Mart. Add Jane as a Windows user, so she accesses Mart using her Windows network credentials. Jane does not provide her user name and password to connect to Mart.

**User Group**

Specifies a user group that is part of an Active Directory. Use this option to add an entire group that accesses Mart. For example, you have a user group ABC-Domain\XYZDivision_AllModelers@MyOrg.com. Add XYZDivision_AllModelers, so that all users that are part of this group and are authenticated by ABC-Domain, connect to Mart. Users of this group do not have to provide their user name and password when they connect to Mart.

**Best Practices to Add a Group User**

The following are the best practices to add a Group User:

- Suppose that you have a parent group that includes subgroups. To give access to all the subgroups under a parent group, add the parent group as a Group User.

- Suppose that you want to give generic permissions to all users of a parent group and specific permissions to a subgroup. Add both, the parent group and the subgroup and give specific permissions to the subgroup. The permissions given to a subgroup take precedence over the permissions given to a parent group.

- Suppose that you want to give generic permissions to a group and specific permissions to a particular user of the group. Add the group and add the particular user as a Windows user. The permissions given to a Windows user take precedence over the permissions given to a group user.
Verify if an Existing Profile Suits the User

CA ERwin DM Version 9 Mart has four built-in profiles:

- Admin
- Architect
- Modeler
- Viewer

Verify if any of these profiles suit the user you have created. If they do not, create the required profile.

How Profiles Work

The way profiles work depends on the following factors:

- The type of user that is assigned to the profile.
- The objects that are included in the profile.
- The permissions that are assigned to the objects.
This section describes the permissions available for various types of users. The section also includes common user profiles and describes permissions for those profiles.

**Type 1: Mart level**

- Includes items under Catalog Management, Mart, Permission Management, Session Management, and User Management.
- Mart level permissions are granted only if a user is assigned to a profile on Mart.
- The Mart level permissions are restricted or allowed at Mart Server itself. The only exception is that Catalog Manager, Open is handled by the client.

<table>
<thead>
<tr>
<th>Catalog Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Open</td>
</tr>
</tbody>
</table>

| Library                     |

<table>
<thead>
<tr>
<th>Mart</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Delete</td>
</tr>
<tr>
<td>✓ Rename</td>
</tr>
<tr>
<td>✓ Update Description</td>
</tr>
</tbody>
</table>

| Locking                     |

| Model                       |

<table>
<thead>
<tr>
<th>Permission Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Modify Permissions</td>
</tr>
<tr>
<td>✓ View Permissions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Profile Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Create Profile</td>
</tr>
<tr>
<td>✓ Delete Profile</td>
</tr>
<tr>
<td>✓ Modify Profile</td>
</tr>
<tr>
<td>✓ View Profiles</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Session Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ End Session</td>
</tr>
<tr>
<td>✓ View Sessions</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Create User</td>
</tr>
<tr>
<td>✓ Delete User</td>
</tr>
<tr>
<td>✓ Modify User</td>
</tr>
<tr>
<td>✓ View Users</td>
</tr>
</tbody>
</table>
Type 2: Catalog Object level

- Includes items under Library, Model, and Version.
- All library privileges, that is, create, delete, and modify are granted when a user is assigned to a profile on the Library or Mart.
- Catalog Object level permissions are restricted or allowed at Mart Server itself. The only exception is that Model, Modify is also verified in CA ERwin DM as part of live semantic.
Type 3: Modeling Object level

- Includes items under Modeling Object.
- Modeling Object level permissions are used for restricting or allowing create, modify, and delete operations on modeling objects within the Catalog of type Model.
- Modeling Object level permissions are restricted or allowed from live semantic in CA ERwin DM.

Permissions

Permission are defined as follows:
- A profile assigned to a user on a catalog.
- A Catalog could be the Mart, a Library, or a Model.

For more information about the types of users, see the Mart Users (see page 27) topic.
Authorization rules for users

The authorization rules for users are explained with examples for profiles and users. This approach helps you relate to a scenario that exists in your work environment and understand the rules better.

The authorization rules are explained based on the following sample catalog structure:

- Mart
  - Library1
    - Model1
    - Model2
  - Library2
    - Model3
    - Model4

Consider the following sample profiles and users:

- Sample profiles P1 and P2
- Sample Server user SU1
- Sample Active Directory (AD) user ADU1
- Sample AD groups ADG1 and ADG2

Authorization Rules for Server User

- Rule 1: P1 assigned to SU1 on Mart
  - SU1 gets the following privileges:
    - Type 1 privileges of P1 on Mart
    - Type 2 privileges of P1 on all libraries and models
    - Type 3 privileges of P1 on all models in Mart

- Rule 2: P1 and P2 assigned to SU1 on Mart
  - SU1 gets the union of P1 and P2 privileges on the entire Mart. Type 1, 2, and 3 privileges are considered. Union here means that if a privilege is restricted in P1 but allowed in P2, it is allowed for SU1.
  - In this case, multiple profile rule does not apply, as the union of privileges is used.

- Rule 3: P1 assigned to SU1 on Library1
  - SU1 gets the privileges assigned for P1 on the entire Library1.
  - Type 1 privileges are not considered.

- Rule 4: P1 assigned to SU1 on Model1
- SU1 gets the privileges assigned for P1 on Model1.
- Type 1 privileges and some Type 2 (Library) are not considered.

■ Rule 5: P1 assigned to SU1 on Mart and P2 assigned to SU1 on Library1
  - SU1 gets the privileges of P1 on Mart and Library2, but not on Library1.
  - SU1 gets the privileges of P2 on Library1.

■ Rule 6: P1 assigned to SU1 on Mart and P2 assigned to SU1 on Model1
  - SU1 gets the privileges of P1 on Mart, Library1, Model2, and the entire Library2, but not on Model1.
  - SU1 gets the privileges of P2 on Model1.

Authorization Rules for Windows User

■ Rule 7:
  - If a Windows user is added as a Mart user, the rules of a Server User apply to the Windows user.

Authorization Rules for Group user

■ Rule 8: P1 assigned to ADG1 on Mart, ADU1 is part of ADG1, and ADU1 not added as user on Mart
  - ADU1 gets the privileges of P1 on Mart.

■ Rule 9: P1 assigned to ADG1 on Mart, P2 assigned to ADG1 on Library1, ADU1 is not added as user on Mart
  - ADU1 gets the privileges of P1 on Mart and Library2, but not on Library1.
  - ADU1 gets the privileges of P2 on Library1.

■ Rule 10: P1 assigned to ADG1 on Mart, P2 assigned to ADG2 on Mart, ADU1 is part of ADG1 as well as ADG2, and ADU1 is not added as user on Mart
  - ADU1 gets the union of P1 and P2 privileges on Mart.

■ Rule 11: P1 assigned to ADG1 on Mart, P2 assigned to ADG2 on Library1, ADU1 is part of ADG1 as well as ADG2, and ADU1 is not added as user on Mart
  - ADU1 gets the privileges of P1 on Mart and Library2.
  - ADU1 gets the union of P1 and P2 privileges on Library1.

■ Rule 12: P1 assigned to ADG1 on Mart, ADU1 is part of ADG1, and ADU1 is also added as user on Mart
  - Since ADU1 is also added as a user on Mart, the user is not considered a part of any group. The rules are same as that of a Windows user.

■ Rule 13: P1 assigned to ADG1 on Mart, P2 assigned to ADG2 on Mart, ADU1 is part of ADG1 only, ADG1 is subgroup of ADG2, and ADU1 is not added as user on Mart
– ADU1 gets the privileges of P1 on Mart. This is because ADG1 is explicitly added on Mart and ADU1 is only part of ADG1.

■ Rule 14: P1 assigned to ADG1 on Mart, P2 assigned to ADG2 on Mart, ADU1 is part of ADG1 as well as ADG2, ADG1 is subgroup of ADG2, and ADU1 is not added as user on Mart

– ADU1 gets the union of P1 and P2 privileges on Mart.
Create a Profile

Profiles determine who can change the data or models in Mart. As a System Administrator, you can create profiles and can attach them to users for a catalog. When a user creates, modifies, or deletes an object in Mart, the profile determines if the operation is permitted. Each profile grants permissions at the following object levels, in the same hierarchical order:

- Catalog Management
- Library
- Mart
- Model
  - Locking
  - Modeling Object
    - Data Movement Rule
    - Data Source Object
    - Default value
    - Domain
    - ER Diagram
    - Entity
    - Relationship
    - Subject Area
    - Theme
    - Validation Rule
    - View
  - User-Defined Property
  - Version
- Permission Management
- Reports
- Session Management
- User Management

Note: Admin, Architect, Modeler, and Viewer profiles are created when you install Mart.

Follow these steps:
1. Open CA ERwin Mart Administrator.
2. To add a profile, follow these steps:
a. Click Add Profile and enter a name for the profile.
b. Enter a description for the profile.
c. Expand the items in the Permission Details section and select the permissions you want to assign.
   Any dependent permissions for the selected permissions are selected too. For example, if you select the Create Entity permission, then Model Modify, ER Diagram Modify, ER Diagram Modify under Subject Area, and Key Group Create permissions are also selected.
d. Click Submit.
   The profile is saved.
3. To create a profile from an existing profile, follow these steps:
   a. Enter a name for the profile.
   b. Select Clone from existing profile and select a profile to clone.
   c. Click Submit.
   d. Expand the items in the Permission Details section and select the permissions you want to assign.
      Any dependent permissions for the selected permissions are selected too. For example, if you select the Create Entity permission, then Model Modify, ER Diagram Modify, ER Diagram Modify under Subject Area, and Key Group Create permissions are also selected.
   e. Click Submit.
      The profile is saved.

**Verify if the Required Library Exists**

When you migrate your models to CA ERwin DM Version 9 Mart, you can choose to create libraries and copy models to them. Verify if you can assign these libraries to the user you want to create. If not, create the required libraries.

**Create a Library**

A library is a collection of related models and a catalog is a group of libraries. Use libraries to add an extra level of security or isolate implementation differences, such as development and production environments.
Adding a User

Follow these steps:

1. Select Mart or an existing library and click New.
   A new library appears with a default name.
2. Change the name per your requirement.
3. Enter a description for the library in the Description field and click Apply.
   A library is created.

Assign Permissions to a User

As a System Administrator, you assign different levels of permissions to different profile users. Control the level of permission and assign a user or a group to a profile so that they have specific access. A user can be assigned to multiple profiles. For example, a user can have full permissions on one library and only view permissions on another.

Follow these steps:

1. Open CA ERwin Mart Administrator.
2. Click Permissions Management, select the libraries that you want the user to access, and select a user or a group.
3. Assign a user or group to a profile and click Submit.
   The profiles is assigned to the user or group.
Examples

This section describes steps to accomplish common business requirements.

Example: Provide permissions to view models in a specific library

Chris, a Business Analyst, has to access Mart to review the models you have copied to the For Review library. Chris only reviews the ER diagrams available in a specific subject area. He may modify the diagrams if required. Chris uses his Windows credentials to log on.

Follow these steps:

1. Add a Windows user named Chris.
2. Create a library named For Review and copy the required model to it.
3. Create a profile named Business Analyst and include the following permissions:
   - Model, Modify
   - Model, Modeling Object, Subject Area, Create and Modify
   - Model, Modeling Object, Subject Area, ER Diagram, Create and Modify
4. Assign the profile to Chris.
   Chris can now log in to Mart using his Windows credentials and review the model.

Example: Set up Mart that allows users save models under a specific library and not under root

You are a System Administrator and you want Jane to create models only under a specific library and not under Mart root.

Follow these steps:

1. Add a Windows user named Jane.
2. Create a library named Projects_Jane.
3. Create a profile named Jane_Profile and include the following permissions:
   - Model, Create
   - Model, Modeling Object, Subject Area, Create and Modify
   - Model, Modeling Object, Subject Area, ER Diagram, Create and Modify
4. Click Permission Management.
6. Click Assign Profile and then click Submit.
   Jane can create models and save them only under the Projects_Jane folder.
Sessions

When you log in to the mart, this event is recorded as the start of a session. During a session, the models that you open and the locks that are applied to each catalog entry are tracked. Each session has its own Action Log, contained in CA ERwin DM, which logs the transaction information containing real-time changes that are made to a model. After you have logged out of the mart, the Action Log is cleared and the session is closed.

Session Manager lets you view a session and terminate your sessions. You can also assign the appropriate permission to a user to terminate a session.

To view a session, click File, Mart, Session Manager. The Session Manager dialog lists all the sessions of the current user.

You can also view and delete offline mart models that are saved in a session.

**Note:** Deleting the offline mart model does not delete the model from the stored location. It deletes the information about that model from CA ERwin DM.

To delete an offline mart model, open the Session Manager dialog, and click Offline Mart Models. The Offline Mart Model Manager dialog opens. Select the Catalog item and click Delete offline mart models. The information about the offline mart model is deleted from CA ERwin DM.

Terminate Inactive or Closed Sessions

Terminate an Inactive or a Closed session to release all the locks applied in that session. If a session is terminated, then all the information that is related to offline mart models in that session is deleted.

**Follow these steps:**

1. Click File, Mart, Session Manager.
   The Session Manager dialog opens. It displays all the sessions of a user.
2. Select a session from the Sessions list and click Delete Session.
   The selected session is terminated.
Delete Mart

As a Mart Administrator, you can delete Mart.

Important! If you delete Mart, all your libraries, models, and the associated data are deleted permanently.

Follow these steps:

1. Open the CA ERwin Mart Administrator and click Delete Mart.
   A warning message appears.
2. Type YES and click OK.
   Mart is deleted and the Initialize Mart web page for your database appears.

Catalog Management

The catalog includes libraries, models, and versions of models. Libraries help you organize projects by grouping models together. For example, you can create a library to store models that share a workgroup, a security level, or a target server. Any number of libraries or models can be created and stored in a catalog. By organizing your data models in libraries, you can also easily manage model merging and conflict resolution.

Library Structure Planning

Before you set up your library structure in the Catalog Manager, review how the workgroup modeling process works in your organization. To help you review your workgroup modeling process, answer the following questions:

- How are CA ERwin DM models moved from the development library to the production library?
- How are the approval process for moving models documented and enforced?
- How are CA ERwin DM models merged into the enterprise model and who controls this process?
- Do you use versioning to record the milestones of models?
- Who has what type of access to each library?
- Are CA ERwin DM models generated to multiple target environments (such as Microsoft SQL Server and Oracle)?
- How are you warehousing your data?
Library Structure Organization

During the model development life cycle, you must have an organized library structure. Having an organized library structure helps you move only those models that are intended for production to that level. You can structure your libraries in three distinct types:

Development Libraries
Contains models that are being created or updated.

Test Libraries
Contains finished models that are being tested before moving them to production.

Production Libraries
Contains the finished models that were tested and debugged.

Library Security Levels

After you have created your libraries, determine the security levels for each library. The following examples give you an idea of how you can use libraries and security together to help safeguard models:

- The entire modeling team can have access to the development library and read-only access to the test and production libraries. Authorized project leaders can be assigned to move models from the development library to the test library, and then from the test to the production library.

- Models from other libraries (for example, Sales and Accounting) can be merged from their own libraries in the enterprise model. Modelers working on projects in the Sales or Accounting libraries can have read-only access to the enterprise library and full access to their own projects. Assign one person or group to manage integration to the enterprise model.

- Modelers need full access to their own libraries and read-only access to the libraries of others. This type of security enhances production for the following reasons:
  - Everyone can see what everyone else is working on.
  - All models are stored in one location.
  - Permissions can be changed as different collaborations among modelers become necessary.
Library Structure Considerations

You must consider any or all of these suggestions when building a library structure:

**Practical library names**

Use practical and functional library names that help all users understand the purpose and type of models contained in the library. For example, you can use the format: Short System Name+Version+Stage (for example, Ora_8_Production).

**Model naming and data type standards**

Enforce naming and data type standards, which are vital to efficient workgroup modeling.

*Note:* For more information, see the *CA ERwin DM Online Help*.

**Rules for promoting models**

Define a rigid and documented model approval and promotion process using different libraries for each development phase.

**Rules for versioning models**

Define versioning rules using different libraries for each development version (for example, Development Beta 1).

**User rights and security**

Apply stricter rights to libraries that contain mature models nearing the latter stages of development. You can also apply strict rights to individual models.

**Publication**

Generate reports to communicate milestones in the model development process.

**Schema generation rules**

Set up a library where you generate the model schema. Usually, you generate the model schema of promoted models only in the latter stages of development.
Manage Catalogs

A catalog is similar to a directory structure. It consists of libraries, data models, model versions, and templates. Catalog Management displays a hierarchical tree of Mart and lets you manage your catalogs. It has all the features included in the Library Manager and Session Manager modules that were available in the previous releases of CA ERwin DM Workgroup Edition.

Following are some of the features in Catalog Management:

Libraries

Use libraries to group related models. Libraries add an extra level of security or isolate implementation differences, such as development and production environments. A library can be part of another library or can be present under the Mart.

Sorting

In a catalog, the libraries are sorted alphabetically, and the models within the libraries are also sorted alphabetically. Versions are sorted newest to oldest; Named Versions appear first, and then Delta Versions follow. The catalog entries sort in the following order: Libraries, Models, Templates, and Versions respectively.

Context Menu

The context menu appears when you select a catalog entry and right-click. You can use the context menu to cut, copy, paste, and delete a library, model, or template. You can also use the context menu to mark a Delta version and delete, hide, and unhide Named and Delta versions.

You can create, delete, copy, and move catalog entries; you can hide and unhide versions.

Follow these steps:

1. Open CA ERwin Mart Administrator and select the Catalog Management panel.
2. To create a library, follow these steps:
   1. Click Create Library.
      A library is created.
   2. In the Edit Catalog section, edit Name and Description fields and click Submit.
      The name and description are updated.
3. To create a Named version, follow these steps:
   1. Select either a Named version or a Delta version of a data model and click Mark Version.
      A Named version is created.
2. In the Edit Catalog section, edit the name and description fields and click Submit.
   
   The name and description of the Named version is updated.

4. To hide a model version, select the version from the Catalog pane, and click Hide Version.

5. To unhide a model version, select the model of that version, click Unhide Version. From the Hidden versions dialog, select your version and click OK.

6. To delete a catalog entry, select the entry and click delete.
   
   The catalog entry is permanently deleted from Mart and it cannot be recovered.
Lock a Catalog Entry

You can lock any catalog entry, even mart, to restrict other users from editing it. You can view the current lock status of a catalog entry in the Locks section. Locks last until the duration of a session or until removed. Locks can last even after a session is disconnected; it means that the user is disconnected from Mart but the lock is still preserved. You can work offline on a model without losing the lock. Only the Administrator can override any lock.

The following lock options are available in Mart:

**Existence Lock**

Prevents other user from deleting a catalog entry. You can edit or move the catalog entry but cannot delete the entry. The presence of an Existence Lock prevents anyone, other than the lock owner, from acquiring an Exclusive Lock on the entry. You can apply Existence Lock, Shared Lock, or Update Lock, with the existing Existence Lock, to the catalog entry.

**Shared Lock**

Prevents the user, including the lock holder, from editing the catalog entry. You can open a model with Shared Lock in read-only mode; you cannot edit the model. The presence of a Shared Lock prevents anyone from acquiring Update Lock or an Exclusive Lock on the entry. You can apply Existence Lock with Shared Lock to a catalog entry.

**Update Lock**

Lets only the lock holder to edit the catalog entry. The presence of Update Lock on an entry prevents other users from acquiring any other locks, except Existence Lock.

**Exclusive Lock**

Lets only the lock holder to edit a catalog entry. The presence of Exclusive Lock prevents anyone from acquiring any type of lock on the entry.

**Unlock Entry**

Lets only the lock holder to unlock an entry.

Depending on the type of lock, you can move any entry in the catalog. Acquire Update Lock on a catalog entry before you move that entry.

You cannot move or copy a catalog entry if any of the following conditions is true:

- the entry has any lock other than Existence Lock or Shared Lock
- the parent of that entry has any lock, other than Existence Lock
- the destination library or mart has any lock, other than Existence Lock
Lock Behavior

When you edit a catalog entry, locks are applied automatically to appropriate levels in the catalog to prevent other users from editing the entry. When the edit is complete, the locks are removed or downgraded automatically.

The following scenarios apply to locks when you edit a catalog entry:

- When you load a model, Shared Lock is applied to the model and Existence Lock is applied to the parent entry up to the mart. After the model is loaded, Shared Lock is replaced with Existence Lock.
- When you initially save a model, Update Lock is applied to the model. After the model is saved, Update Lock is replaced with Existence Lock.
- When you incrementally save a model, Update Lock is applied to all the versions created between the opened version and the newly created version. After the model is saved, Update Lock is replaced with Existence Lock.
- When you delete a model, Exclusive Lock is applied to the model. After the model is deleted, the lock is dropped.
- When you delete a user, all the locks that the user had applied are deleted.
- When you rename a library, Update Lock is applied to the library. After the library is renamed, the lock is removed.
- When you load models for version compare, Shared Lock is applied to the root model. After the model is loaded, Shared Lock is removed.
- When you merge or import objects during version compare, Update Lock is applied to the root model. When the merge or import is complete, Update Lock is removed.

Chapter 3: Workgroup Modeling Reports

Modelers typically work from a common set of libraries and models, and share information about these objects with other users. One way to share information is by using reports, which details the information and definitions for a model.

Generate predefined reports to view the contents of specific libraries and models, view the changes and conflicts for specific models, and view the security structure for the database. Use either the standard or customized reports to see detailed information for a specific model.

Note: Some reports described can only be generated by the Mart Administrator. You can generate Mart reports only if you have installed Crystal Report Developer Edition on the computer on which you want to generate the reports.
CA ERwin DM Workgroup Edition includes the following predefined reports:

**Global Reports**

The following table describes the global reports that you can run against Mart:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes By Name</td>
<td>Provides information for a specified attribute name—logical and physical, including its library, and its owning diagrams and entities.</td>
</tr>
<tr>
<td>Derived Models</td>
<td>Provides a list of all models that are created using the Derive Model process.</td>
</tr>
<tr>
<td>Entities by Name</td>
<td>Provides information for a specified entity name—logical and physical, including library, its owning diagrams, and owned attributes or columns.</td>
</tr>
<tr>
<td>Libraries</td>
<td>Provides a list of all libraries in Mart.</td>
</tr>
<tr>
<td>Library Model Entity</td>
<td>Provides a hierarchical list of all entities in models and libraries.</td>
</tr>
<tr>
<td>Library Model Version</td>
<td>Provides a list of the versions of all models.</td>
</tr>
<tr>
<td>Library Model</td>
<td>Provides a list of the models in the selected libraries.</td>
</tr>
<tr>
<td>Mart Domains</td>
<td>Provides a list of all domains used by diagrams, sorted by diagram and library. Includes the domain name, domain parent, domain parent name, and domain data type.</td>
</tr>
<tr>
<td>Models with Subject Areas</td>
<td>Provides a list of all Subject Areas and the diagrams in each Subject Area in a model.</td>
</tr>
<tr>
<td>Models</td>
<td>Provides a list of all the models in the entire Mart. The report includes details such as the number of entities and attributes, and the total number of model objects.</td>
</tr>
<tr>
<td>Subject Areas</td>
<td>Provides the list of all subject areas, including subject area members.</td>
</tr>
<tr>
<td>User Defined Properties</td>
<td>Provides a list of all user-defined properties for the current open model, including UDP name, class name, and default value.</td>
</tr>
<tr>
<td>Users</td>
<td>Provides a list of all users assigned to Mart, including user numeric ID and server login.</td>
</tr>
</tbody>
</table>
Model Validation Reports

The following table describes the model validation reports that can be run against models in the mart:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes without Definition</td>
<td>Provides a list of all attributes that have no definition text for the specified model.</td>
</tr>
<tr>
<td>Attributes without Domains</td>
<td>Provides a list of all attributes that have no domain association for the specified model.</td>
</tr>
<tr>
<td>Entities whose Primary Keys are all Foreign Keys</td>
<td>Provides a list of entities in all the models that have foreign keys as their primary keys.</td>
</tr>
<tr>
<td>Entities without Definitions</td>
<td>Provides a list of all entities that have no definition text for the specified model.</td>
</tr>
<tr>
<td>Entities without Primary Keys</td>
<td>Provides a list of all entities that have no primary key for the specified model.</td>
</tr>
<tr>
<td>Many to Many Relationships</td>
<td>Provides the details of many-to-many relationships available in all the models in the Mart.</td>
</tr>
<tr>
<td>Model Attributes without Definition</td>
<td>Provides a list of all attributes that have no definition for the specified model.</td>
</tr>
<tr>
<td>Unattached Entities</td>
<td>Provides a list of entities that are not the parent of a relationship. The report includes information for all the models in Mart.</td>
</tr>
</tbody>
</table>

Diagram Reports

The following table describes the reports that can be run against diagrams:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Definitions</td>
<td>Provides the definition information of the specified diagram.</td>
</tr>
<tr>
<td>Domains</td>
<td>Provides the domain usage of the specified diagram.</td>
</tr>
<tr>
<td>Entities</td>
<td>Provides the entity information for the specified diagram.</td>
</tr>
<tr>
<td>Entity Attributes</td>
<td>Provides the details of all the entities and their attributes in the selected model.</td>
</tr>
<tr>
<td>Entity PK FK</td>
<td>Provides the details of primary and foreign keys for all the entities in the selected model.</td>
</tr>
<tr>
<td>Entity Subtypes</td>
<td>Provides the details of all the entity subtypes for the selected model.</td>
</tr>
<tr>
<td>Report Name</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Entity Supertypes</td>
<td>Provides the details of all the entity supertypes for the selected model.</td>
</tr>
<tr>
<td>Entity Table Attribute Column Datatype Nulls</td>
<td>Provides a list of all data type null values for entity attributes and table columns for the selected model.</td>
</tr>
<tr>
<td>Model Subject Areas</td>
<td>Provides a list of the Subject Areas and their members for the selected model.</td>
</tr>
<tr>
<td>Index Members</td>
<td>Provides a list of the index member usage for the specified diagram.</td>
</tr>
<tr>
<td>Index Properties</td>
<td>Provides the index properties for all objects in use for the specified diagram.</td>
</tr>
<tr>
<td>Relationships</td>
<td>Provides a list of relationship usage for the specified diagram.</td>
</tr>
</tbody>
</table>

**Model Locks Report**

Provides information about the lock status of all models in the selected library.

View and manage report results in the CA ERwin Reports Viewer. Use the predefined reports available on the Tools menu, use either the Bulk Editor to view and edit object properties in the current model and export results to a CSV file, or use the Query Tool to execute predefined or customized SQL SELECT statements against a model.

**Model Contents by Class**

The Model Contents by Class report includes ERwin objects available in the selected model based on their class.

**Bulk Editor**

The Bulk Editor provides the selection, validation, and maintenance of model object metadata, permits reusable customization (option sets), and realtime access to model changes. Export results or selected rows to a CSV file. You can use the Bulk Editor to edit a small set of properties over a large number of objects. Changes and updates are immediately committed as you make them, field by field.

**Query Tool**

The Query Tool is used to query the repository through executing SQL SELECT statements against a local model or a model in the mart. You can use the Query Tool to create your own .QRY report file. Save your option set locally to the model or as an XML file. Export your results to a CSV file. You can execute a query against the objects and properties in the model, the metadata defining those objects and properties, and the action log that records the changes that are made to your model during the modeling session. You can create new queries or paste text from another source (such as a .SQL file) into a query. Although the Query Tool provides a built-in query interface in CA ERwin DM, you can also use any third-party reporting tool that has ODBC capability to query CA ERwin DM modeling data.
Generate a Global Report

Global reports provide information about Mart including its libraries, models, model objects, and diagrams. To run the Global Reports, you must have Mart level permissions.

Note: Connect to Mart to view the available reports and to generate a global report.

Follow these steps:

1. Click Tools, Mart Reports, Global Reports, then select one of the following reports:

   Attributes By Name
   Provides information for a specified attribute name--logical and physical, including its library, and its owning diagrams and entities.

   Derived Models
   Provides a list of all models that are created using the Derive Model process.

   Entities by Name
   Provides information for a specified entity name--logical and physical, including library, its owning diagrams, and owned attributes or columns.

   Libraries
   Provides a list of all libraries in the mart.

   Library Model Entity
   Provides a hierarchical list of all entities in models and libraries.

   Library Model Version
   Provides a list of the versions of all models.

   Library Model
   Provides a list of the models in the selected libraries.

   Mart Domains
   Provides a list of all domains used by diagrams, sorted by diagram and library. Includes the domain name, domain parent, domain parent name, and domain data type.

   Models with Subject Areas
   Provides a list of all Subject Areas and the diagrams in each Subject Area in a model.
Models

Provides a list of all the models in the entire Mart. The report includes details such as the number of entities and attributes, and the total number of model objects.

Subject Areas

Provides the list of all subject areas, including subject area members.

User Defined Properties

Provides a list of all user-defined properties for the current open model, including UDP name, class name, and default value.

Users

Provides a list of all users assigned to Mart, including user numeric ID and server login.

The Database Login dialog opens.

2. Enter login information and click Connect.

Depending on the report requested, either the generated report opens in the viewer or you are prompted to enter additional parameters for the report. Once these parameters are entered, the report opens.

The report is generated and opens in the viewer.

3. Use the toolbar options to export or print the report.

4. Click Exit on the File menu.

The Report Viewer closes.
Generate a Model Validation Report

Run a model validation report to validate your model to ensure complete and accurate model information. To run the Model Validation Reports, you must have Mart level permissions.

**Note:** Connect to Mart to generate a model validation report.

**Follow these steps:**

1. Click Tools, Mart Reports, Model Validation Reports, then select one of the following reports:

   **Attributes without Definition**
   - Provides a list of attributes that have no definition text in all the models in the Mart.

   **Attributes without Domains**
   - Provides a list of attributes that are not owned by any domains in all the models in the Mart.

   **Entities whose Primary Keys are all Foreign Keys**
   - Provides a list of entities in all the models that have foreign keys as their primary keys.

   **Entities without Definitions**
   - Provides a list of entities that have no definition text in all the models in the Mart.

   **Entities without Primary Keys**
   - Provides a list of all entities that have no primary key in all the models in the Mart.

   **Many to Many Relationships**
   - Provides the details of many-to-many relationships available in all the models in the Mart.

   **Model Attributes without Definitions**
   - Provides a list of all attributes that have no definition in all the models in the Mart.

   **Unattached Entities**
   - Provides a list of entities that are not the parent of a relationship. The report includes information for all the models in Mart.

The Database Login dialog opens.
2. Enter login information and click Connect.
   Depending on the report requested, either the generated report opens in the viewer or you are prompted to enter additional parameters for the report. Once these parameters are entered, the report opens.
   The report is generated and opens in the viewer.

3. Use the toolbar options to export or print the report.

4. Click Exit on the File menu.
   The Report Viewer closes.
Generate a Diagram Report

Diagram reports provide information about the current diagram open in the mart. To run the Model Validation Reports, you must have Mart level permissions.

**Note:** Connect to Mart to view the available reports and to generate a diagram report.

**Follow these steps:**

1. Click Tools,Mart Reports,Diagram Reports, then select one of the following reports:

   **Definitions**
   - Provides the definition information of the specified diagram.

   **Domains**
   - Provides the domain usage of the specified diagram.

   **Entities**
   - Provides the entity information for the specified diagram.

   **Entity Attributes**
   - Provides the details of all the entities and their attributes in the selected model.

   **Entity PK FK**
   - Provides the details of primary and foreign keys for all the entities in the selected model.

   **Entity Subtypes**
   - Provides the details of all the entity subtypes for the selected model.

   **Entity Supertypes**
   - Provides the details of all the entity supertypes for the selected model.

   **Entity Table Attribute Column Datatype Nulls**
   - Provides a list of all data type null values for entity attributes and table columns for the selected model.

   **Model Subject Areas**
   - Provides a list of the Subject Areas and their members for the selected model.

   **Index Members**
   - Provides a list of the index member usage for the specified diagram.

   **Index Properties**
   - Provides the index properties for all objects in use for the specified diagram.

   **Relationships**
Generate a Model Lock Report

Provides a list of relationship usage for the specified diagram.
The Database Login dialog opens.
2. Enter login information and click Connect.
   Depending on the report requested, either the generated report opens in the viewer or you are prompted to enter additional parameters for the report. Once these parameters are entered, the report opens.
   The report is generated and opens in the viewer.
3. Use the toolbar options to export or print the report.
4. Click Exit on the File menu.
   The Report Viewer closes.

Generate a Model Lock Report

The Model Lock report provides information about the lock status of all the models in a library.

Note: Connect to Mart to view the available reports and to generate a model lock report.

Follow these steps:
1. Click Tools, Mart Reports, Other, Model Lock.
   The Database Login dialog opens.
2. Enter login information and click Connect.
3. Enter additional parameters for the report.
   The report is generated and opened in the viewer.
4. Use the toolbar options to export or print the report.
5. Click Exit on the File menu.
   The Report Viewer closes.
Generate a Report on Model Contents by Class

The Model Contents by Class report includes ERwin objects available in the selected model based on their class.

**Note:** Connect to Mart to view the available reports and to generate a class-wise content report.

**Follow these steps:**

1. Click Tools, Mart Reports, Other, Model Contents by Class.
   The Database Login dialog opens.
2. Enter login information and click Connect.
3. Enter additional parameters for the report.
   The report is generated and opened in the viewer.
4. Use the toolbar options to export or print the report.
5. Click Exit on the File menu.
   The Report Viewer closes.
The Report Viewer

The Report Viewer lets you view reports created with Crystal Reports. It opens when you select a report to generate on the Tools menu. It provides a way to view the report you selected to run, and work with options for exporting and printing the report.

Use the following features to work with the Report Viewer:

- **Export Report**
  Specifies to export the report to a folder you specify. After it is exported, you can share the report with others. The default format is as a Crystal Reports report (.rpt), but you can specify one of the following additional formats:
  - Adobe PDF (.pdf)
  - Microsoft Excel (97-2003) (.xls)
  - Microsoft Excel (97-2003) Data-Only (.xls)
  - Microsoft Word (97-2003) (.doc)
  - Microsoft Word (97-2003) - Editable (.rtf)
  - Rich Text Format (.rtf)
  - XML (.xml)

- **Print Report**
  Specifies to print the report.

- **Refresh**
  Specifies to refresh the information in the report.

- **Toggle Parameter Panel**
  Lets you toggle the display of the parameter panel. The panel shows the input parameters as provided to generate the report. If the report contains no parameters, the view is empty.

- **Toggle Group Tree**
  Lets you toggle the display of the tree hierarchy of the objects on which you generated the report.

- **Go to First Page**
  Goes to the first page of the report.

- **Go to Previous Page**
  Goes to the previous page of the report.

- **Go to Next Page**
  Goes to the next page of the report.
Chapter 4: Generate the Current Diagram Picture

In addition to using the integration of Crystal Reports to create a picture report of the model diagrams, you can also use the Tools menu in CA ERwin DM to generate a picture report of diagrams.

To generate the current diagram picture
1. Open the diagram for which you want to generate a picture.
2. Click Diagram Picture, Generate Current Diagram Picture on the Tools menu.
   The Save As dialog opens.
3. Enter a name and location for the file and click Save.
   The generated file is saved as an .EMF (Enhanced Metafiles) image and the Save As dialog closes. To view or print the diagram image, use any image viewer program to open the file.
Index

D
database
  manage • 10

M
Microsoft SQL Server
  settings • 9
  modeling, workgroup • 9

R
recommendations
  standards • 10
reports
  generate • 59